Legal Notes

Unauthorized reproduction of all or part of this guide is prohibited.
The information in this guide is subject to change without notice.
We cannot be held liable for any problems arising from the use of this product, regardless of the information herein.
© 2019 KYOCERA Document Solutions Inc.

Regarding Trademarks

Microsoft®, Windows®, and Active Directory® are registered trademarks of Microsoft Corporation in the U.S. and/or other countries.
All other brand and product names herein are registered trademarks or trademarks of their respective companies.
Table of Contents

Chapter 1 Basic Information
KYOCERA Net Manager System Documentation.................................................................1-1
What is KYOCERA Net Manager? .........................................................................................1-1

Chapter 2 Web interface
Starting Net Manager web........................................................................................................2-1
Net Manager user interface......................................................................................................2-1
Home tab dashboard..................................................................................................................2-2
   Adding and managing gadgets on the dashboard..............................................................2-3
   Printing a file......................................................................................................................2-3
   Recharging credit..............................................................................................................2-4
   Changing your PIN..........................................................................................................2-5
Jobs.......................................................................................................................................2-6
   Changing the job owner..................................................................................................2-6
   Changing the assigned print queue..............................................................................2-7
   Changing the assigned project.....................................................................................2-8
Reports..................................................................................................................................2-9
   Creating report folders..................................................................................................2-9
   Creating custom reports...............................................................................................2-10
   Setting the schedule for custom reports.................................................................2-11

Chapter 3 Common printing tasks
Direct print...............................................................................................................................3-1
Secure / delayed print (Print&Follow)..................................................................................3-1
Secure copying.......................................................................................................................3-1

Chapter 4 Managing print jobs
Marking print jobs as favorites..........................................................................................4-1
Pausing a print job................................................................................................................4-1
Pushing a job to the print queue..........................................................................................4-2
Deleting a print job............................................................................................................4-2
Job roaming.........................................................................................................................4-3

Chapter 5 Smart Job Manager
Smart Job Manager widget..................................................................................................5-1
Logging in to SJM as current user.......................................................................................5-1
Logging in to SJM with login authentication......................................................................5-2
Chapter 6  KYOCERA Net Manager Mobile Print integration

Scanning documents on iOS devices................................................................. 6-1
Printing documents on iOS devices............................................................... 6-2
Scanning documents on Android devices....................................................... 6-3
Printing documents on Android devices....................................................... 6-4

Chapter 7  Working with Embedded Terminal

Log into Embedded Terminal............................................................................ 7-1
Two-factor authentication.............................................................................. 7-1
Embedded Terminal panel screen................................................................. 7-2
Log out of Embedded Terminal..................................................................... 7-2
Printing My Jobs with Embedded Terminal.................................................. 7-3
Using projects with Embedded Terminal and a Print&Follow queue............ 7-3
Using Easy Scan with Embedded Terminal................................................... 7-4
Using Easy Copy with Embedded Terminal................................................... 7-4
Using Easy Scan continuous........................................................................ 7-5
Using Panel Scan with Embedded Terminal.................................................. 7-6
Using Panel Copy with Embedded Terminal.................................................. 7-7
Using Panel Fax with Embedded Terminal.................................................... 7-8
Using Panel USB with Embedded Terminal................................................... 7-8
Accessing Applications in Embedded Terminal............................................ 7-9
About folders in Embedded Terminal............................................................ 7-9
Deleting jobs in Embedded Terminal............................................................ 7-10
Registering a new ID card............................................................................ 7-11
Using credit and a voucher with Embedded Terminal.................................... 7-11
Unlocking the device panel in Embedded Terminal........................................ 7-12
Using Job roaming....................................................................................... 7-13
Using Anonymous Scan and Copy and Fax................................................... 7-14
Accessing the Embedded Lite terminal......................................................... 7-15
1 Basic Information

KYOCERA Net Manager System Documentation

<table>
<thead>
<tr>
<th>KYOCERA Net Manager New Features Guide</th>
<th>Provides an overview of the new features available in KYOCERA Net Manager.</th>
</tr>
</thead>
<tbody>
<tr>
<td>KYOCERA Net Manager Administrators Guide</td>
<td>Describes administration and configuration features such as accounting, cloud licensing, remote terminal management, upgrade, server backup, uninstallation.</td>
</tr>
<tr>
<td>KYOCERA Net Manager Embedded Terminal Guide</td>
<td>Describes the installation and configuration of the KYOCERA Net Manager Embedded Terminal and use of Terminal Manager.</td>
</tr>
<tr>
<td>KYOCERA Net Manager Installation Guide</td>
<td>Provides instructions for installing software and initial configuration, searching printing devices, adding users, creating print queues, assigning terminals to printing devices, and setting up printer drivers.</td>
</tr>
<tr>
<td>KYOCERA Net Manager User Guide</td>
<td>Describes the KYOCERA Net Manager web interface and the KYOCERA Net Manager Embedded Terminal.</td>
</tr>
</tbody>
</table>

What is KYOCERA Net Manager?

KNM is a server-based web application that manages your print devices and user policies to provide secure printing and copying and to provide accounting of print-related expenses. Efficient use of your printing resources is provided by the Print&Follow function which allows users to securely print to any printer managed by KYOCERA Net Manager.

KYOCERA Net Manager offers many advantages:

**Authentication**

Access the devices in one step by PIN, ID card or user name/password or in a two-step authentication combination such as ID card and PIN

**Security**

Secure printing, data encryption and the Print&Follow function ensure that your documents can only be accessed and printed by authorized people
**Basic Information**

**Reporting**
KYOCERA Net Manager keeps detailed statistics about all aspects of printing and printers, scanning and copying, projects, accounting and users and groups.

**Personalized Features**
KYOCERA Net Manager allows IT administrators to show different functions and applications per user based on the user's requirements.

**Easy Scan**
One click changes the destination of your scanned documents and their metadata. You may choose between your home folder, fax server, or email address.

**Mobile printing**
Print documents from your mobile device by sending the job to the KYOCERA Net Manager server or using the mobile app.
2 Web interface

The KYOCERA Net Manager user interface can be displayed in one of the supported web browsers: Google Chrome, Internet Explorer, Microsoft Edge, Safari, and Mozilla Firefox. Contact your system administrator for the KNM web address and your credentials if you have not received them.

Starting Net Manager web

1 Open a web browser and enter one of the following URLs to get to the KNM web interface:
   • http://[ip address or hostname of the server]:8080 for non-SSL
   • http://[ip address or hostname of the server]:8090 for SSL

2 Select a language from the drop-down menu.

3 Enter the user name and the password given to you by your system administrator.
   User access can also be established through the domain policy of your network. If instructed by your system administrator, use your network login credentials for KNM.

Net Manager user interface

The KNM user interface is displayed after you log in successfully. The default view is the Home tab with current user and job information displayed. Click the Kyocera logo for additional options, or click any of the Quick Links.
Home tab dashboard

The Home tab dashboard shows the number of paused jobs, favorite jobs, and jobs ready to be printed.

With the credit system activated, you are informed of your current account balance and have an option to display your credit history. If quotas for users or departments are enabled, you are shown the current limits for your individual quota.

If enabled, you may edit your user profile and generate a new PIN for your account.

Credit and quotas may not be available for all systems.

You can customize a dashboard to provide quick access and views of KNM features and resources. The dashboard can be customized by selecting gadgets. Gadgets display status, device and system information, or provide access to KNM features.
Available gadgets include Credit, Quota, Jobs, Quick links, Printers with issues, Scanned documents, and User profile. Credit and Quota must be enabled before they can be available as gadgets.

Adding and managing gadgets on the dashboard

You can add a gadget to the Home tab dashboard. Once the gadget appears, you can edit, delete, or change the gadget's position.

1. Click **Add a new gadget**.
2. In the Gadget drop-down menu, select a gadget.
3. Click **OK**.
4. To relocate a gadget, hover over the gray bar at the top of the gadget until a cross symbol appears. Click, hold, and drag the gadget to a new location.
5. To delete a gadget, click the drop-down menu and select **Delete**.

Printing a file

You can print a file through the User Web Interface. The option, when enabled by your administrator, is located at the bottom of the Jobs gadget. The format allowed for printing via this interface are: .pdf, .bmp, .jfif, .jpe, .jpeg, .jpg, .mime, .myqurl, .png, .tif, .tiff, .txt.

MS Office format support must be enabled. MS Office formats include: .doc, .docx, .xls, .xlsx, .ppt, .pptx, .odp, .ods, and .odt.

1. Click **Print File**.
2 Click **Choose File** to load your file.

3 Select the appropriate check box: B&W, Economic mode, or Duplex.

4 Enter the number of copies to print.

5 Click **OK**.

The job appears in the job queue as **Ready job**.

**Recharging credit**

You can add credit to your account by entering a voucher number, through PayPal, or an administrator can recharge credit for users or groups. PayPal capability must be enabled by the KNM administrator and is not a default feature.

1 Click **Recharge Credit**.
2 Enter a voucher number (or a recharge amount for PayPal, if enabled) and click Recharge Credit on the Recharge Credit screen.

The system displays an OK confirmation, your account is increased by the value of the voucher or amount requested through PayPal, and the new Account balance is displayed.

You will need to login to PayPal to confirm the payment.

Changing your PIN

Your KNM Administrator can grant the ability to change your PIN.

1 Click Generate PIN.

2 Click OK to confirm.

3 Record your new PIN and click OK.
If the Administrator has set up email notifications, your new PIN is also sent to your email address.

Jobs

In the Jobs tab, you can monitor print jobs in various stages of processing.

- The Ready folder shows all jobs waiting to be printed
- All paused jobs can be displayed by clicking on the Paused folder
- If a job is printed, it is moved to the Printed folder
- The jobs marked as favorites are included in the Favorite folder
- Deleted jobs display in the Deleted folder
- A complete overview of all print jobs is found in the All folder

If Job roaming is enabled, there will also be a Job roaming folder.

Changing the job owner

You can change the job owner only if you have sufficient rights. The system administrator can move print jobs between users, and to heads of user groups. Heads of user groups can move jobs between users in the group.

1. Double-click a job to open the General information screen.
2. Click the Owner drop-down menu and select a new owner.
3. Click Save.
If the selected owner does not have rights to print from the assigned print queue, changing the job owner is not possible, and an error message appears.

**Changing the assigned print queue**

You can change the print queue only if you have sufficient rights (assigned by the system administrator).

1. Double-click a job to open the General information screen.
2. Click the **Queue** drop-down menu and select a new queue.
3. Click **Save**.
If the user does not have rights to the new print queue, the queue is not displayed.

### Changing the assigned project

You can change the assigned project only if you have sufficient rights (assigned by the system administrator), including rights to the new project.

1. Double-click a job to open the General information screen.
2. Click the **Project** drop-down menu and select a new project.
3. Click **Save**.
Reports

KNM has a large number of reports available through the web interface. By default, users have access to three of these reports. However, the KNM Administrator can grant rights to users and groups for any built-in or customized reports. See the KNM Administrator Guide for more information.

These procedures tell you how to use default reports for users with basic user rights.

Creating report folders

You can create folders under My reports.

1. Access Reports from the logo menu or Quick Links.
2. Click Add and select New folder.
3 Enter a name for the folder and click **OK**.

**Creating custom reports**

Users can create their own custom reports based on the default types of Users reports: Daily summary, Monthly summary, and Session details.

1 Click **Add** and select **New** report.

2 Select **Type**.

3 Select the folder where you want the report to appear.

4 In the General tab, enter the name of the report and description.

5 In the General tab, under **Sharing**, select the users who can run the report and select users who can edit the report.

6 Select the Design tab to configure the following options:
   - **Options** - select report orientation and whether to show filters in the report
   - **Filters and parameters** - set filtering options and parameters
   - **Table** - To change design elements for the report, select a table row and click **Edit**
     - **Table** - to add design elements, click **+Add**
   - In the Summary column, choose whether to display summary data in the table; choices are None or Sum
Setting the schedule for custom reports

You can schedule a task to run a report on a periodic basis.

Click **Save**.
You can schedule a report to run later, on a set schedule, or save a report with the configured parameters to run in the future.

1 Select a saved report and click **Edit**.

2 Click **Schedule** on the General tab, under **Scheduled run**. The scheduling panel opens.
3. In the General tab that appears for Schedule, select how often to run the report, the days to run the report, and the times to run the report.

4. Under Notification, select who should receive the task notification.

5. Select **Only in case of an error** to receive a notification only when there’s a problem with the report.

6. Under Report, select **Format** and **Language**.

7. Enter the custom subject, recipient, and message in **Send via email**. You must select recipients for the report or enter a title and location for the saved report under **Save to a file**.

8. Click **Save**.

9. In the Rights tab, add other users who will have access to and be able to manage this report.

10. Click **Save** in the General tab to save the schedule.
3 Common printing tasks

In addition to standard Direct print, printing devices managed by KNM and equipped with an authentication mechanism (Embedded Terminal, Embedded Lite, an ID card reader, etc.) can use secure/delayed print (Print&Follow), secure copy, scan, and fax.

Direct print

When you select Print in the menu of an application and then select the printing device connected to the direct queue in KNM, the job is immediately sent to the printing device.

After the job is printed, the number of pages used in the job is charged to the user’s account if credit accounting is enabled. Direct print is used only for controlling the print volume and does not support any advanced functions. Direct print does not require logging on to the terminal.

Do not use direct print for confidential documents if the printer is not secured from unauthorized access.

Secure / delayed print (Print&Follow)

The print job sent to the secure (Print&Follow) queue is not printed immediately, but is stored on the KNM server. When the job owner logs in to the printing device, the panel is unlocked and their print job is completed. If the KNM Administrator has enabled it, all other active print jobs in queue are printed. If not, the user can manually release print jobs after logging on.

Secure copying

By default, the panel of the printing device is locked. When a user logs in, the system verifies access rights. After successful authentication, the panel is unlocked and the user can use the device for copying and other tasks. After finishing the work, the user logs out or is logged out automatically after a specified period of time.
4 Managing print jobs

Log in to the KNM web interface to perform the following Print job tasks.

Marking print jobs as favorites

When a print job is printed frequently (for example, printing standardized forms), it is useful to mark the print job as a Favorite. The job is moved to the Favorite folder where it can be pushed to the print queue at any time. Favorite jobs are not deleted by the system.

1. Click Jobs on the Home tab or the logo menu.
2. Select a job from the appropriate folder: Ready, Paused, or Printed.
3. Click Actions, then Favorite.

The Favorite flag is added to the print job.

To remove the Favorite flag, select a favorite job, click Actions then click Favorite again.

Pausing a print job

1. Click Jobs on the Home tab or the logo menu.
2. Select a job from the Ready folder.
3. Click Actions, then Pause.
Managing print jobs

The job is moved to the Paused folder.

Pushing a job to the print queue

All the print jobs that have not yet been deleted by Net Manager can be pushed again to the print queue. This feature can be used for favorite and paused print jobs.

1. Click Jobs on the Home tab or the logo menu.
2. Select a job from the Paused folder.
3. Click Actions, then Push to print queue.

The status changes to Ready and the job is moved to the Ready folder. Depending on the type of selected queue, the document is immediately sent to the printing device or waits until you log on to the selected printing device.

Deleting a print job

You can delete a print job that has been already sent to the Net Manager server.

1. Click Jobs on the Home tab or the logo menu.
Managing print jobs

2 Select a job from the appropriate folder: Ready, Paused, or Printed.

3 Click Actions, then Delete.

4 Confirm the deletion.

The job is moved to the Deleted folder.

Job roaming

With the Job roaming feature configured, jobs sent to the Print&Follow queue on any site server can be displayed in two places:

- KNM web interface
- Embedded terminal
5  Smart Job Manager

Smart Job Manager widget

Smart Job Manager (SJM) is a utility installed on the client computer that allows enabled users to manage their jobs, credit and quotas. SJM comes with a widget that provides information on current connection state, number of jobs that belong to a user, methods of login, and user credit and quota information. An Administrator can add a custom logo and link for SJM.

If you installed the desktop link, you can access SJM by clicking the link icon. You can also open SJM by clicking the SJM icon in the 'hidden icons' triangle icon in the system tray.

Immediately after installation, the SJM interface opens in the bottom right corner of the desktop and displays the logged in user. If the user does not exist on KNM or if the server is unreachable, a Server is offline message appears instead.

You can use an alias if the Windows OS login user is not a user in KNM.

Once the user exists in KNM and the server is reachable, a CONNECTED message displays. The interface varies in appearance, depending upon which authentication method was set during installation.

Logged on user

The current user on the OS is automatically logged in.

Login

The user must login with the authentication method set during installation.

User list

A user is selected from the user list and logged in.

Logging in to SJM as current user

When Logged on User is the authentication method, the user currently logged in on the OS is logged in to SJM.
Logging in to SJM with login authentication

Click **Login** and enter authentication credentials. The authentication method includes one or more of these methods:

**Username and password**

Enter your username and password. Click **Remember me** and choose how long to save your credentials. Click **OK**.
PIN

Enter your PIN. Click **Remember me** and choose how long to save your credentials. Click **OK**.

ID card

Select **Remember me** and swipe your card.

![Reminder Icon]

You may need to press **Enter** after swiping the card.

Click **logout** to log out.
Logging in to SJM with user list authentication

1. Click Login.
   The list of users is displayed. The list is limited to 15 users.
   If the user is not in the list, use the search bar to find the user.

2. Select the user and click OK.

Using SJM to send jobs

Users see different SJM screens after logging in, depending upon whether credit or quotas have been enabled or not enabled. If both have been enabled, credit takes precedence. The following screens show options for a user using the Logged on user authentication method.

Credit - the screen shows the logged on user's credit balance.
Quota - the screen shows the logged on user's quota used and the actual quota numbers. In the example Test User has used 0% of their quota, or has used 0 of 10 allowed pages of the type being monitored (Total pages, Color Pages, Scanned pages or Price, as set by the KNM Administrator).

The following user is using the Login authentication method with all three login options enabled:

- PIN
- ID card
- Username and password
After logging in, the number of pending jobs and the first job name are both displayed. The user has the option to delete or print the job or jobs.
If there is more than one pending job, the user may select **Apply to all jobs** to take the same action with all of the jobs.

If Apply to all jobs is selected, the job name is no longer displayed.

If the user has projects, the user can set favorite projects by clicking the star icon next to the project name. Favorite projects display at the top of the list.

A maximum of 15 projects can be displayed at once.
A user can search for a specific project by typing the project name in Search Project.
If a user sends a job to a queue that has credit and a price list assigned to the printer, then the job price will display.
The administrator sets the queue that is used.

If the queue has multiple printers assigned to it, with different price lists for different printers, then a range of possible prices display.
6 KYOCERA Net Manager
Mobile Print integration

Mobile printing can be managed by KYOCERA Net Manager. This allows policies, quotas, and credits to be applied to mobile device users.

KYOCERA Mobile Print can support Direct Print and Print&Follow printing based on the print queue that is selected by the user.

Windows authentication is not supported in KYOCERA Mobile Print. iOS or Android mobile device users must manually enter their username and password into their mobile devices.

If you are unable to log in to the KYOCERA server when using KYOCERA Mobile Print, check that the login method selected is Net Manager, and that User login and Job Accounting are disabled.

The mobile user interface for printing and scanning is different on iOS and Android devices. See the following for instructions for each OS.

Scanning documents on iOS devices

1. Open the KYOCERA Mobile Print application.
2. Tap Scan.
3. Tap Select a device at the bottom of the screen.
4. Choose the scanning device to use from the following:
   - Favorites
   - Recent
   - Discover
   - Manual (input IP address or host name)
   - QR (scan a QR Code with the mobile device camera)
5. Tap a device. After the checkmark appears, tap Select.
6. Open Scanning preferences, scroll down, and select Net Manager.
7. Configure KYOCERA Net Manager settings:

   Server
   - Enter the IP address or hostname of the KYOCERA Net Manager server.

   Port
   - Enter 9094.
**User name**
Enter your KYOCERA Net Manager user name.

**Password**
Enter your KYOCERA Net Manager password. This is not your PIN.
Contact your KNM administrator if you don’t have a password.

**IPP or IPPS**

8 Tap the Net Manager slider icon to set it to **On**. A Success message displays once connected.

9 Tap **Done**.

10 Optional – Set scanning preferences.

11 Close Scanning preferences.

12 Place document to be scanned on the scanner and tap **Scan**.

13 Tap **Select Destination** and pick a location or cloud service for saving your scan.

14 Tap **Save** to save your scan to the selected folder or cloud service. Format choices (in Scanning preferences) are PDF, JPEG and TIFF.

**Printing documents on iOS devices**

1 Open the KYOCERA Mobile Print application.

2 Select a document source: Documents, Photos, Camera, Clipboard, Web, Dropbox, Evernote, OneDrive, Google Drive, Shared Folder, or QR Code.

3 Select a document.

4 Open Printing preferences, scroll down, and tap Net Manager.

5 Configure the KYOCERA Net Manager settings:

   **Server**
   Enter the IP address or hostname of the KYOCERA Net Manager server.

   **Port**
Enter 9094.

   **User name**
Enter your KYOCERA Net Manager user name.

   **Password**
Enter your KYOCERA Net Manager password. This is not your PIN.
Contact your KNM administrator if you don’t have a password.
KYOCERA Net Manager Mobile Print integration

IPP or IPPS
6 Tap the Net Manager slider icon to set to On. A Success message displays once connected.
7 Tap Done.
8 Optional – Set printing preferences.
9 Close Printing Preferences.
10 Tap Select queue. You’ll see three tabs, Print&Follow, Direct, and Delegated Printing queues. Tap one of the tabs.

If there are no queues configured of the type you select, there will be no queue names in the tab. Tap a different queues tab.

11 To select a queue, tap the queue name. After the checkmark appears, tap Select.
12 Tap Print.

Scanning documents on Android devices
1 Open the KYOCERA Mobile Print application.
2 Select Scan.
3 Tap Select device at the bottom of the screen.
4 Choose a scanning device to use from the following:
   • Favorites
   • Recent
   • Discover
   • Manual (input IP address or host name)
   • QR (scan a QR Code with the mobile device camera)
5 Tap a device to select it.
6 Open the Settings menu and select Net Manager.
7 Configure KYOCERA Net Manager settings:
   Server
       Enter the IP address or hostname of the KYOCERA Net Manager server.
   Port
       Enter 9094.
User name
Enter your KYOCERA Net Manager user name.

Password
Enter your KYOCERA Net Manager password. This is not your PIN.
Contact your KNM administrator if you don’t have a password.

IPP or IPPS
8 Tap OK. Back on the Settings screen, the slider icon is to set to On.
9 Tap Back to return to the scanning screen.
10 Optional - Set scanning preferences.
11 Place document to be scanned on the scanner and tap Scan.
12 Tap Save to save a copy of your scan to the Documents folder. File format choices in Scanning preferences are PDF, JPEG and TIFF.

Printing documents on Android devices
1 Open the KYOCERA Mobile Print application.
2 Select a document source: Documents, Photos, Camera, Clipboard, Web, Dropbox, Evernote, OneDrive, Google Drive, Shared Folder, or QR Code.
3 Select a document.
4 Open the Settings menu and select Net Manager.
5 Configure the KYOCERA Net Manager settings:

Server
Enter the IP address or hostname of the KYOCERA Net Manager server

Port
Enter 9094

User name
Enter your KYOCERA Net Manager user name

Password
Enter your KYOCERA Net Manager password. This is not your PIN.
Contact your KNM administrator if you don’t have a password.

6 Tap OK. Back on the Settings screen, the Net Manager slider icon is set to On.
7 Tap Back to return to your document preview.
8 Optional - Tap **Printing preferences** and make adjustments as needed.

9 Tap **Select queue**. You’ll see three tabs, Print&Follow, Direct, and Delegated Printing queues. Tap one of the tabs.

If there are no queues configured of the type you select, there will be no queue names in the tab. Tap a different queues tab.

10 To select a queue, tap the queue name. After the checkmark appears, tap **Select**.

11 Tap **Print**.
7 Working with Embedded Terminal

KNM Embedded Terminal supports displaying and controlling printing device functions directly from the control panel of the printing device. Users can release jobs held in KNM Print&Follow, Delegated or other queues. Users can also use scan, print, fax, and copy functions (depending on the capabilities of the device) directly on the device from the Embedded Terminal.

Log into Embedded Terminal

The two most common ways to log on to Embedded Terminal are by tapping an ID card on the card reader (on devices equipped with readers) or by entering a PIN on the terminal and tapping OK.

The KNM Administrator configures log in requirements for Embedded Terminal. Log in can be through any combination of:

- ID card
- PIN
- Username and Password

Two-factor authentication

If a higher level of security is necessary, the KNM administrator may require users to authenticate using two elements, such as an ID card and PIN or Password. If two-factor authentication has been enabled, tap your ID card on the reader and then enter your PIN or password at the terminal keypad to log in.
Embedded Terminal panel screen

The system administrator configures the appearance of the user interface of the Embedded Terminal panel. KNM supports a maximum of 9 buttons on the panel. Functionality can be expanded by creating folders and subfolders for additional buttons.

If credit accounting is enabled, you can see your available credit.

Log out of Embedded Terminal

To end an Embedded Terminal session, you may:

- Tap the logout button on the panel
- Tap your card on the reader again
- Press the Authentication/Logout button on the keypad (hard key)
If you do none of these, the terminal logs you off after a preset interval.

**Printing My Jobs with Embedded Terminal**

1. Log in to the terminal using the authentication method set by the Administrator.
2. Tap **My Jobs**.

![My Jobs](image)

To print all jobs queued to your account, tap the **Print All** panel button.

3. Tap the row with the jobs you want to print.
4. Tap **Print**.
5. After finishing your print jobs, log out. (See Log out of Embedded Terminal for detail.)

After My Jobs are printed, they are removed from the Ready folder in the web interface.

**Using projects with Embedded Terminal and a Print&Follow queue**

1. Log in to the terminal using the authentication method set by the Administrator.
2. Select a printing, copying, or scanning option on the panel. The terminal displays the project window.
3. Choose a project.
If the Net Manager Administrator has enabled printing without a project, you may select a project, but are not required to do so.

---

Using Easy Scan with Embedded Terminal

1. Log in to the terminal using the authentication method set by the Administrator.
2. Place your document in the document processor or directly on the platen.
3. Tap Easy Scan to start scanning.

There may be two choices for Easy Scan: Email (send the scan to an email address) and Folder (save the scan to a folder).

4. If project accounting is enabled on the server, select a project to associate with the job.
5. After finishing your scan, log out. (See Log out of Embedded Terminal for details.)

---

Using Easy Copy with Embedded Terminal

This feature not available on all printing device models.
1 Log in to the terminal using the authentication method set by the Administrator.

2 Tap **Easy Copy** on the touch panel.

![Easy Copy](image)

3 If project accounting is enabled on the server, select a project to associate with the job.

4 After finishing your print jobs, log out. (See Log out of Embedded Terminal for details.)

**Using Easy Scan continuous**

- Continuous scan must be enabled by the Administrator.

1 Log in to the terminal using the authentication method set by the Administrator.

2 Place your document on the platen.

3 Tap **Easy Scan** on the touch panel to start scanning.

- There may be two choices for Easy Scan: Email (send the scan to an email address) and Folder (save the scan to a folder).

4 If project accounting is enabled on the server, select a project to associate with the job.

5 Remove each page from the platen and replace it with the next page in the job. Tap **Next**.

6 When the scan job is complete, tap **Finish**.
7 After finishing your scan, log out. (See Log out of Embedded Terminal for details.)

Using Panel Scan with Embedded Terminal

Select Panel Scan to unlock the terminal and manage scanning details from the device's Send screen.

1 Log in to the terminal using the authentication method set by the Administrator.

2 Tap Panel Scan on the touch panel.

3 If project accounting is enabled on the server, select a project to associate with the job.
4 After finishing your scan, log out. (See Log out of Embedded Terminal for details.)

Using Panel Copy with Embedded Terminal

Select Panel Copy to unlock the terminal and manage copy job details from the device's Copy screen.

1 Log in to the terminal using the authentication method set by the Administrator.

2 Tap Panel Copy on the touch panel.

3 If project accounting is enabled on the server, select a project to associate with the job.

4 After finishing your copy, log out. (See Log out of Embedded Terminal for details.)
Using Panel Fax with Embedded Terminal

Select **Panel Fax** to unlock the terminal and manage fax job details from the device's Fax screen.

1. Log in to the terminal using the authentication method set by the Administrator.
2. Place your document in the document processor or directly on the platen.
3. Tap **Panel Fax** on the touch panel.
4. After finishing your fax, log out. (See Log out of Embedded Terminal for details.)

Using Panel USB with Embedded Terminal

Select **Panel USB** to unlock the terminal and manage removable memory from the device's removable memory screen. After a USB drive has been inserted, you can print and manage files on the drive from the Panel USB screen. You can also scan and save files to the drive. If you leave the USB panel screen without removing the drive, you can return to the drive by tapping **Panel USB** again. You can also safely remove the drive by tapping **Remove Memory** on the screen.
1 Log in to the terminal using the authentication method set by the Administrator.

2 Tap **Panel USB** on the touch panel.

3 After working with the files on the USB drive, log out. (See Log out of Embedded Terminal for details.)

**Accessing Applications in Embedded Terminal**

This feature not available on all printing device models.

1 Log in to the terminal using the authentication method set by the Administrator.

2 Tap **Application List** on the touch panel to access the menu with available applications.

3 After finishing your work with applications, log out. (See Log out of Embedded Terminal for details.)

**About folders in Embedded Terminal**

The Embedded Terminal panel can only display nine buttons. If more are buttons needed, the Administrator can create folders and sub folders to expand the display capability of the panel. If you do not see the panel button you are looking for, look in a folder for more options.

1 Log in to the terminal using the authentication method set by the Administrator.

2 Tap the **Folders** button on the touch panel.

   ![Folders button](image)

   The name of the button is assigned by the Administrator and may not be as pictured in the sample below.
After working in the folders, log out. (See Log out of Embedded Terminal for details.)

Deleting jobs in Embedded Terminal

1 Log in to the terminal using the authentication method set by the Administrator.
2 Tap My Jobs on the touch panel.
3 Tap the row with the jobs you want to delete. The selected rows are highlighted and have a checkmark.
4 Tap Delete (the trash icon) on the touch panel.
When you are done, log out. (See Log out of Embedded Terminal for details.)

The deleted jobs are removed from the Ready folder.

### Registering a new ID card

1. Type your PIN using the keyboard and tap **OK** on the touch panel.
2. Tap **ID Card Registration** on the touch panel.
3. Tap the new ID card on the Embedded Terminal card reader. Net Manager posts a message about the success or failure of the registration.
4. After finishing registering new ID cards, log out. (See Log out of Embedded Terminal for details.)

### Using credit and a voucher with Embedded Terminal

You can add credit to your account from the touch panel. When your credit is too low, a message posts on the panel and the credit window is displayed so you can replenish your credit balance before performing or releasing jobs.

1. Log in to the terminal using the authentication method set by the Administrator.
2. Tap **Recharge Credit** on the touch panel.
To see the device's price list, tap the stack of coins on the **Recharge Credit** screen.

3 In the **Code** box, type your voucher code. If the code is valid, your credit balance is replenished.

KNM displays either a success or failure message upon entering the voucher number.

4 After finishing, log out. (See Log out of Embedded Terminal for details.)

**Unlocking the device panel in Embedded Terminal**

1 Log in to the terminal using the authentication method set by the Administrator.

2 Tap **Unlock Panel** on the touch panel.
Use the device features as permitted by your access privileges.

After finishing your work, log out. (See Log out of Embedded Terminal for details.)

**Using Job roaming**

Job roaming gives users the ability to print jobs that were saved on a different site server.

1. Log in to the terminal using the authentication method set by the Administrator.
2. Tap **My Jobs** on the touch panel.
3. Tap the **Remote** tab. Selected print jobs are moved from the remote Net Manager server to the local Net Manager server.
The Remote tab has an Options menu with buttons for the following actions:

**Print the job**
Tap the job to select and tap the printer icon.

**Download**
Download the job from the remote KNM server to the local site server.

**Cancel download**
Leave job on the remote KNM server.

**Delete the job**
Delete from the local KNM server. Tap the job and tap the trash icon.

4 After finishing your remote session, log out. (See Log out of Embedded Terminal for details.)

**Using Anonymous Scan and Copy and Fax**

Anonymous scan and copy and fax allows users to access device features without authentication. It is available for copying, scanning, and faxing when the Lock icon is displayed in the upper right of the touch panel.

1 Tap the **Lock** icon on the touch panel.

2 You can use the Copy and Scan or Fax selections on the touch panel, depending on how the Administrator configured your settings.
After finishing your work, press the **Authentication/Logout** button on the keypad (hard key).

**Accessing the Embedded Lite terminal**

For the Embedded Lite Terminal login, use the authentication method set up by the Administrator. The panel unlocks and all your print jobs waiting in queue will be printed (model dependent) or you can select jobs to print. After finishing your work, press the **Authentication/Logout** button on the keypad (hard key). Logging out with your ID card is not available. You can also allow the terminal to time out and log you out.